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INTRODUCTION 

How to use this course unit 

This course unit is not a manual but a combination of theory and workshops with which 

to learn the programme on a 1-to-1 basis. Every mouse-click and every entry is 

described in detail, providing you with a teaching resource that lets you learn the basics 

of the programme by yourself. Each chapter provides explanations, information, and a 

workshop to practise the functions. To enable the workshops to be completed 

smoothly, the explanations should be read through very carefully. The order of 

chapters should not be changed because each workshop builds on the previous one. 

The programme DVD contains examples stored as an ELITECAD file, enabling 

problematic places to be reviewed. 
 

Conventions used in this course unit 
 

The start and end of a workshop are marked as follows: 

 WORKSHOP  

  WORKSHOP END 

Functions are written in block capitals. The corresponding icon also appears for new 

functions.  

FUNCTIONS (BLOCK CAPITALS)  

 
 

Functions can be accessed directly using icons (buttons). The functions are grouped 

together in toolbars or in the large tool management. 

  

[Enter] 

Function keys on the keyboard appear within square brackets. 
 

Input values (bold) 

Input values must be entered using the keyboard. When the text is entered in the input 

line, it must be confirmed with the [Enter] key. 
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PREPARATION 

 WORKSHOP  

In this course unit we start with the project CAD_Object6. 

First, load the project. 
 

1. Open project 

 

 

Select the project "CAD_Object6" and confirm with OK. 
 

2. Menu FILE > OPEN 

Select the model "Starting Position" and open it. 
 

The opened model should look as follows. 

 

  WORKSHOP END 
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MATERIALIZATION 

State materials for objects  
A function for materials allocation is offered in the respective parameter screens. 

 

Users can toggle between material mode and colour mode. 
 

Material mode    Colour mode 

  
 

Allocating materials using "drag and drop" 

The other option for allocating materials is using "drag and drop". The material can be 

dragged and dropped from the Materials editor onto the component in question. 

 
 

TIP 
If you want to allocate the same material to multiple surfaces or objects, 

etc., there is a multiple allocation function. Drag the material onto a 

surface as normal. However, instead of releasing it, press the [Shift] key 

on the keyboard or the "+" sign. Click and hold down the mouse and 

move it to a different surface before pressing one of the two buttons. 

This can be repeated any number of times.  
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 WORKSHOP  

1. Open the Materials editor. 

Menu View > Window > Material... or use the key combination [Ctrl]+[7]. 
 

2. Switch the allocation mode to "Replace". 

 
 

3. In the Materials editor, double-click to switch to the folder "Boards". 

 
 

4. Drag and drop the material "Planks001" onto the fence. 
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5. In the materials editor, switch to the folder above. 

 
 

6. Double-click on the folder "Timber", drag and drop the material "Maple001" onto 

the fence. 

 
 

7. In the Materials editor, switch to the main folders. 

 
 

8. Double-click on the folder "Surroundings/Grounds/Lawn+Grass", drag the material 

"Lawn002" and drop it onto the lawn. 
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9. In the materials editor, switch to the folder above. 

 
 

10. Double-click on the folder "Surroundings/Grounds/Nutrient Media", drag the 

material "Loam001" and drop it onto the ground. 

 

 

11. In the materials editor, switch to the folder above. 

 

 

12. Double-click in the folder "Surroundings/Grounds/Board lining", and drag and 

drop the material "Gardendish011" onto the seat. 
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13. Now add the remaining materials. 
 

 Garage door: Wood/Cladding/Sheeting004 

 Street: Surroundings/Grounds/Hard planes/Asphalt002 

 Forecourt and sidewalk: Surroundings/Grounds/Hard planes/Asphalt005 

 Kerb: Surroundings/Grounds/Hard planes/Asphalt001 

 Retaining wall for street: Stone/Concrete/Coarse concrete/Course concrete003 

 Retaining wall house: Stone/Concrete/Exposed concrete/Exposed concrete004 

 Exterior staircase: Stone/Concrete/Exposed concrete/Exposed concrete002 

 Roof: Stone/Tile/Rooftiles/Tile101 

 Masonry: Finery/Finery/Finery001 

 Tinwork: Metal/Metals/Copper 

 Banister: Metal/Metals/Chrome 

 Window glass: Glass/Glasses/Pane glass 
 

The model should now look roughly as follows. 

 

  WORKSHOP END 

TIP 
Materials that were accidentally allocated can be deleted by clicking 

"Material for delete". Depending on the "allocation mode", the material 

is deleted on the relevant planes.It’s also possible to delete the name of 

the material and switch back to colour mode. 
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VIEW POSITION 
This function is used to observe the 3D object from any point and in any direction. 

You can finely tune the direction of view using the camera screen below. The design 

model depiction is automatically set to be in perspective. 

 WORKSHOP  

1. Activate "Without structure". 

 

Important: In the ARS version of ELITECAD, you cannot perform any action in 

Storeys Manager because the model has more than one structure. It does not matter 

that another storey may be currently active. You can specify the height of the camera 

in the camera window as you prefer. 
 

2.Image start position and ZOOM ON FORMAT.(or use [CTRL+Pos1])” 

 
 

3. Select the function View position. 

 

Please click VIEW POSITION or ENTER 
 

4. Using the capture mode Freehand select the point P1. 

Please enter height of view position 
 

5. Enter the value 300 into the input line and confirm the value [Enter]. 

Please click point of vision 
 

6. Using Capture Freehand mode, select point P2. 

Please enter height for point of vision 
 

7. Enter the value 300 into the input line and confirm the value [Enter]. 

 

P

1 

P

2 
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  WORKSHOP END 
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CAMERA 
Modifikations will be done in the 4-views window of the camera. If the camera screen 

is open, only the camera symbol can be clicked in CAD. Selecting or manipulating 

CAD objects is not possible. 

The depiction of the design model view can be controlled separately. If you right-click 

in this area, a menu opens where you can select how the design model view should be 

depicted. This is also true for the other views, as they are interconnected. 

 

 
 

Using the camera in the 4-view window 

Various handles are available, which you can use to manipulate the camera 

interactively while left-clicking. 
 

Modify position of camera  Move camera 

   
 

Modify direction of camera  Modify opening angle of camera  

Front view Side view left 

Floor plan Design model view 
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 WORKSHOP  

1. Set the opening angle in the camera screen to 60. This modification can be done 

with the slider or input direct a value in the field. 

 
 

2. Correct the angle of view so that the model is located roughly in the middle of the 

model window. 

 
 

3. Leave the camera adjustment by closing the 4-window-mode and confirm the 

request with YES. Close now the camera window. 
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  WORKSHOP END 

 

CREATE DESIGN MODEL VIEW. 
This function stores the 3D view angle currently set on your model as model view.  

In case you wish to change the view angle of a view model, right-click in the view and 

select "Modify cut-out" from the context menu. You are now "within" the limitation 

framework and can move around using the centre mouse button and the zoom 

functions, as usual. The size of the section can also be changed using the handles. The 

camera position and the section are saved by pressing [Esc] or CANCEL.  

 

 WORKSHOP  

1. Create new design model view. 

 
 

2. Enter the name, set the display to solid, switch the background on and switch to 

material mode. 

 



Visualisation  

www.elitecad.eu 14 

3. In the material mode, click on the selection button and then on Surroundings. 

 
 

4. Now switch to the folders Background/Land/ and select the material Land007. 

  

 
 

5. Next, confirm the screen with OK. 
 

6. Load the model view onto the screen. 

 

 

7. Save work copy [Ctrl]+[W] 

  WORKSHOP END 
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MOVE BACKGROUND IMAGE 
Depending on the camera setting and angle, moving or scaling the background image 

is required so that it fits correctly. To do so, right-click to open the context menu. Here 

you will see two menu items for Moving and Scaling. If you also press [Ctrl] when 

scaling, the image can be modified not to scale. 

 WORKSHOP  

1. Right-click in the model window and select Move background image. 

 

Please indicate reference point 
 

2. Now left-click in the image. 

Please enter NEW position for alignment point 
 

3. Set down the background image roughly as shown below. 

 
 

4. The function remains active so that the action can be repeated until the image is 

correct. Afterwards, cancel the function with [Esc]. 

  WORKSHOP END 
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CREATE INTERIOR VIEW 
Now try to define another model view in the interior. 

 WORKSHOP  

1. Return to the model view and define another viewpoint in the living area. 

 

 
 

2. Save this camera as new model view as well. Enter the name Interior view and use 

the same options as described above. Load the view onto the screen and move the 

background image, too. 
 

3. Allocate materials to the interior view. 
 

 Slab: Wood/Parquet/Parquet block/Oak006 

 Stairs: Wood/Parquet/Parquet block/Oak006 

 Truss: Wood/Timber/Ash001 

 Roofing: Wood/Cladding/Sheeting022 

 Oven: Metal/Metals/Alu 

 Banister: Metal/Metals/Chrome 

 Kitchen worktop: Stone/Quarry stone/Marble/Marble002 

 Slab faces for stair exit: Finery/Finery/Finery001 
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The interior view should now look roughly as follows: 

 

  WORKSHOP END 
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LIGHT SOURCES 
Like the camera, the light sources are set in a 4-view window. Control using the right 

mouse button is the same as with the camera. 

For each view, the light sources can be switched on or off separately and their intensity 

individually controlled. 

 

Using the light sources in the 4-view window 

Depending on the light type, there are various handles available, which you can use to 

manipulate the light type interactively by left-clicking on them. 
 

Here is a spotlight, for example: 
 

Modify position of light source Move light source 

   
 

Modify direction of light source Modify opening angle of light source  

   
 

Front view Side view left 

Floor plan Design model 

view 
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 WORKSHOP  

1. Load the model view "Exterior view". 

 
 

2. Open the light parameters, deactivate "Camera light" and "Sun", activate "Front" 

and modify the following settings for the same light source.  

Ensure that the light source by which you set the intensity and the shadow resolution 

is also selected in the list. 

 

  
 

TIP 
Do not set the controller for shadow resolution to an unnecessarily high 

level, since detailed resolution will also use more internal memory. 

Gradually raise the slider until you are happy with the result. 

  
3. Leave the light adjustment by closing the 4-window-mode and confirm the request 

with YES. Close now the light window. 
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4. Load the model view "Interior view" onto the screen. 

 
 

5. Open the light parameters, deactivate "Camera light" and "Sun", activate "Side left" 

and modify the following settings for the same light source.  
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6. Right-click in the model window and select the point "Render model". 

 
 

7. Set the light source with the handles roughly in such a way as shown below and 

confirm the screen with OK. 

 
 

8. Switch to solid mode. 

 
 

9. Save work copy [Ctrl]+[W] 

  WORKSHOP END 
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RENDER 

 WORKSHOP  

1. Load the model view "Exterior view". 

 
 

2. Access the screen parameters. 

 
 

3. During rendering, select the data record "good" and click OK to close the screen. 

 
 

4. Trigger rendering. 

 
 

5. The progress is displayed in the information line. 
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6. The image should now look roughly as follows: 

 
 

7. Load the model view "Interior view" onto the screen. 

 
 

8. Access the screen parameters, select the data record "good" and close the screen 

with OK. 

 
 

9. Start rendering. 

 
 

10. The image should now look roughly as follows: 
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  WORKSHOP END 

 

TIP 
The rendered image is "frozen" and is no longer automatically up to 

date. If the model view remains in render mode, it can be brought up to 

date by clicking "Refresh view". 

  
 

EDIT MATERIAL 
All properties that a material displays such as image texture, transparency, mirroring, 

shine, etc. can be set or modified in the Materials editor. 

If a material is changed that is stored in the database, a query appears as to whether 

the change is saved again to the database or whether a new material should be 

generated. If you click "No", a new material is generated with a name extension and 

automatically relocated. This new material is only present in this drawing and if you 

right-click on it, it can be stored to the database (DB). 
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 WORKSHOP  

1. Load the model view "Exterior view". 

 
 

2. Switch to solid mode. 

 
 

3. In Materials Manager, right-click on a folder or click on a material and select the 

point "Edit material by surface". 

 
 

4. Now left-click on the lawn. The materials editor opens. 
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5. On the left-hand side, click on the effect "Texture" and under Division change the 

material width to 200.  

The change in the preview window becomes visible on the right-hand side. 

 
 

6. Now click on APPLY. 

A prompt appears asking you whether or not you wish to save the change directly to 

your database. Click NO and then close the main screen with OK. 

 
 

7. Load the model view "Interior view" onto the screen. 

 
 

8. Switch to solid mode. 

 
 

9. In Materials Manager, right-click on a folder or click on a material and select the 

point "Edit material over surface", and then click on the parquet flooring. 
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10. On the left-hand side, left-click on the name of the material and activate 

"Mirroring" from the possible effects.  

 
 

11. On the left-hand side, click on the effect "Mirroring" and under intensity set the 

controller to 6. 

 
 

12. Click APPLY, confirm the prompt with NO and then close the main screen with 

OK. 
 

13. Save work copy [Ctrl]+[W] 

  WORKSHOP END 
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AREA RENDER 
For larger design models, the complete rendering process may take a long time. That 

is why there is an option to use range rendering to depict a specific range of the drawing 

as a rendering design model. The active render parameters are taken into account. The 

rest of the image is preserved in the previous depiction. 
 

The function remains active so you can change the render setting and view the results, 

until you cancel range rendering using [Esc]. 

 WORKSHOP  

1. In Materials Manager, right-click on a folder or click on a material and select the 

point "Edit material over surface", and then click on the glass. 
 

2. On the left-hand side, left-click on the name of the material and activate "Mirroring" 

from the possible effects.  

 
 

3. On the left-hand side, click on the effect "Mirroring" and under intensity set the 

controller to 10. 
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4. Click APPLY and confirm the prompt with NO. 

5. Switch to Area render mode. 

 

first point 
 

6. Click on point P1. 

second point 
 

7. Click on point P2.  

The relevant area is now shown as rendered. 

 
 

8. Set the controller in the material editor to 20 and click APPLY. 

P

1 

P

2 
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9. Click again on the points P1 and P2 or on a different section. 
 

10 Repeat until you are happy with the result. Afterwards, cancel area rendering with 

[Esc] and then close the material editor. 

 

  WORKSHOP END 

RADIOSITY 
Daylight rendering is a process for rendering the energy distribution of atmospheric 

light in the scene. This energy diffusion enables a basic illumination level as would be 

found on a cloudy day, which you can combine with other light sources. 

If you wish, the result may be saved with the drawing. Menu "Settings > Options > 

Save/Load > Drawing". This setting is “on” by default. In the CAD_Object6 example 

file, the setting is “off” for space reasons on the DVD. 

 WORKSHOP  

1. Load the model view "Exterior view". 

 
 

2. Trigger rendering. 

 
 

3. Access screen parameters, adjust the following settings and then close the screen 

with OK. 
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4. Refresh view. 

 
 

5. The progression is displayed in the information line. Following the radiosity 

calculation, the system automatically carries on rendering. 

 

 
 

6. Since the radiosity calculation works like an additional light source, the ambient 

light must be reduced. Open the light parameters, confirm the prompt with 

"Temporarily switch to solid mode" and change the intensity of the ambient light to 

25. 
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7. Close the screen with OK. Rendering will be triggered again. 
 

8. Load the model view "Interior view" onto the screen. 

 
 

9. Trigger rendering. 

 
 

10. Access screen parameters, set the following settings and then close the screen with 

OK. 
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11. Refresh view. 

 
 

12. Open the light parameters, confirm the prompt with "Temporarily switch to solid 

mode" and change the intensity of the ambient light to 20. 

 

  
 

13. Close the screen with OK. Rendering will be triggered again. 

  WORKSHOP END 
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Exterior view 

 
 

Interior view 

 
 

TIP 
When working, it is advisable to use the "preview" depiction and only 

to use optimal rendering where necessary and for the final image. 

  
 

TIP 
After rendering has been completed, the intensity of the result can be 

adjusted retroactively without the need to run the rendering again. If you 

reset the slider to "0", the radiosity result will be deleted.  
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RADIOSITY UPDATE 
Once the radiosity has been rendered once, it is not automatically refreshed when the 

geometry is modified or if new material is allocated. The daylight rendering process 

must be manually restarted.  

 WORKSHOP  

1. Load the "model" view onto the screen. 

 
 

2. Access the menu item "Insert", select "Load into" and confirm the prompt with "to 

startpoint". 

  
 

3. Select the template "Parts of Library.d" and open. Confirm the subsequent prompt 

with OK. 

 
 

4. Load the model view "Exterior view". 
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5. Refresh view.  

 

6. As yet the new parts have no radiosity illumination. Right-click in the model 

window and select the item "Radiosity Update". Radiosity and rendering will be 

recalculated. 

 
 

7. Refresh the radiosity for the Interior view as well. 

  WORKSHOP END 

Exterior view 

 
  



Visualisation  

www.elitecad.eu 37 

Interior view 

 
 

TIP 
If in a plot compilation render images with radiosity are present, the 

radiosity update can also be carried out in the plot for multiple views. 

Right-click in the model window and select the item "Radiosity 

Update".  
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VIEW WITH RENDER IMAGE 
Calculated 2D views of your model can also be defined with render images. 

 WORKSHOP  

1. In views management, select "Front view" from among the model views. 

 
 

2. In Layer management switch the "Surroundings" layer to invisible. 

 
 

3. Open the light parameters, deactivate "Camera light" and "Sun", activate "Front" 

and set the intensity of the ambient light to 30. Close the screen with OK. 
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4. Create new view. 

 
 

5. Adjust the following settings. 

  
 

6. Next, open the render parameters on the same screen, adjust the following settings 

and close the screen by clicking OK. 

 

    
 

7. Close the main screen with OK. The view will be calculated. 
 



Visualisation  

www.elitecad.eu 40 

8. Load the "South façade" view onto the screen. 

 

  WORKSHOP END 

South façade 

 

The view can continue to be enhanced with 2D library parts. 

 

EXPLANATION 
Display 

 

You can use this button to determine whether, for the view, a solid image 

or render image is defined or not, in addition to the lines. 
 

Hidden line      

Only lines are displayed. 
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Solid 

The colour surfaces are added to the background of the line display. 

 
 

Render 

The render image is added to the background of the line display. 
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DEFINE CUT-OUT 
If you right-click in the view, a menu item "Define cut-out" appears or,  

if one is already present, "Modify cut-out " and "Remove cut-out ". 

         

The function "Define section" determines an area to which the visibility of the view is 

restricted. Partial areas can therefore be defined from larger views. If you click 

"Modify section" the handles of the limitation framework become visible on which the 

section can be changed. Click "Remove section" to delete the limitation framework. 

 WORKSHOP  

1. Load the "South façade" view onto the screen. 

 
 

2. Right-click in the view and select the point "Define cut out". 

 
 

3. Drag the rectangle across P1 to P2. 

 

 

4. Delete the 4 view lines with the function DELETE SEGMENT. 

This deletion generates a deletion line (blue) that continues to cover these lines and is 

not printed out. 

 

P

1 

P

2 
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5. Refresh view. 

 
 

6. Save work copy [Ctrl]+[W] 

  WORKSHOP END 
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DEFINE PLOT 

 WORKSHOP  

1. Create new plot. 

 

Enter a name and the format and confirm with OK. 

 
 

2. Set plan edge. 

In the menu click "LAY-OUT > FORMAT FRAME. 

 
 

3. INSERT VIEW 
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Click on the "Exterior view" and then on OK. 

 
 

4. Set the view to the top left. 

 
 

5. The view is too large. Load the model view "Exterior view". 

 
 

6. Change the scale to 1:100. 
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7. Load the plot view onto the screen. 

 
 

8. PLACE VIEW 

 

Insert the views "Interior view" and "South façade". 
 

9. Align views. 

 

Click on the view in question and position it. The function remains active and can be 

carried out for as long as required until it is cancelled with [Esc]. 
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10. Save work copy [Ctrl]+[W] 

  WORKSHOP END 

 

TIP 
In the plot, the render images can also be combined with normal vector 

plans.  
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MODIFY SECTION (PLOT) 
Within the plot it is also possible to work directly in the sub views. 

 WORKSHOP  

1. Load the plot view onto the screen. 

 
 

2. Double-click on the limitation framework of the south façade. The frame is 

highlighted red in this condition. 
 

3. Right-click in the view and select the point "Modify cut-out". 

 

4. Widen the view using the handles created and align with the others. 
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5. Update the view within the plot. If need be, execute the radiosity update. 

 
 

6. To deactivate the view, either left-click outside this view in the plot or click on the 

name of the plot in views management. 

 

  WORKSHOP END 
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CALCULATE FINAL IMAGES 
The quality of the images can be adjusted to your requirements. Do not set the quality 

unnecessarily high while working. Only do so before rendering the final image. 

Be also advised to lower the quality of the images when editing the project for long 

periods, and to increase it again when you are finished. 

The level of quality that can be set depends on your computer and its RAM. The size 

of your model is also a factor. If an image can no longer be calculated, a message 

appears on the screen. If this happens, the quality must be lowered. 

In the CAD_Object6 example file, the quality is set to half of that in the description 

for space reasons on the DVD. 

 WORKSHOP  

1. Load the model view "Exterior view". Ensure that the image is rendered. 

 
 

2. Access screen parameters, modify the following settings and then close the screen 

with OK. 

 

  
 

3. Refresh view. If need be, execute the radiosity update. 
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4. Do the same for the view "Interior view" as well. 
 

5. For the "South façade" you reach the rendering parameters via the general screen 

parameters since the view is not a pure rendering. Set the same settings there as well 

but remain with the "Resolution" for image quality. Next, close both screens with OK. 

 

 

 
 

6. Refresh view. If need be, execute the radiosity update. 

 
 

7. Save work copy [Ctrl]+[W] 

  WORKSHOP END 
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SAVE IMAGE 
Rendered model views can be saved as an image file.  

 WORKSHOP  

1. Load the model view "Exterior view". Ensure that the image is rendered. 

 
 

2. In the menu "File > Export" select the point “Pixel format…". 

 
 

3. The "Write pixel format" screen opens. Enter a file name and confirm it with "Save". 

The image will be saved in the selected folder as an image file. 
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4. Do the same for the view "Interior view" as well. 
 

5. The procedure is slightly different for the "South façade". Since the view is not pure 

rendering and also contains lines, the resolution must be entered manually. 

Load the view "South façade" onto the screen and from the menu "File > Export" select 

the menu item "Pixel format…". Enter the pixel size as follows: 

 
 

6. Right-click in the view and select the point "Print preview". 

 
 

7. Click OK to confirm the screen "Pixel format". The "Pixel format" screen opens. 

Enter a file name and confirm it with "Save". The image will be saved in the selected 

folder as an image file. 
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  WORKSHOP END 

 

TIP 
For "Write bitmap" for normal views, always use the aspect ratio of the 

image.  
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PRINT 
If colour gradient hatches or transparencies exist in plans, certain printer drivers may 

not print them as transparent. In this case, the option "Print in highest quality" must be 

selected in the SETTINGS menu > SYSTEM > CONFIGURATION. 

 WORKSHOP  

1. Load the plot view onto the screen. 

 
 

2. Click on the PRINT symbol. 

 
 

3. Print on format size A2: 

Select the relevant printer or plotter, select the format under "Properties" and under 

"Range" select "Format". 

 
 

4. Print on format size A3: 



Visualisation  

www.elitecad.eu 56 

Select the relevant printer or plotter, select the format under "Properties" and under 

"Range" select both "Format" and also the "Modify" option. 

 
 

5. Save the file. 

  WORKSHOP END 
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